
Q .1Q .1 In whic h y ear  was  the firs t  cens us  held  in Ind ia?In whic h y ear  was  the firs t  cens us  held  in Ind ia?
A nsA ns 1. 1875

2. 1877
3. 1879
4. 1872

Q .2Q .2 What is  the name of the mas c ot for  the Khelo  India  Youth G ames  2 0 2 5,  and what does  it  repres ent?What is  the name of the mas c ot for  the Khelo  India  Youth G ames  2 0 2 5,  and what does  it  repres ent?
A nsA ns 1. Simhaketu – A lion deity from the Konark Sun Temple carvings

2. Gajraj – A traditional elephant from Kerala festivals
3. Himmat – A royal tiger from the Satpura forest
4. Gajsingh – A mythical elephant-lion from Pala-period temples

Q .3Q .3 In whic h y ear  was  A lai  Darwaza bui lt  by  A lauddin Khal j i?In whic h y ear  was  A lai  Darwaza bui lt  by  A lauddin Khal j i?
A nsA ns 1. 

2. 
3. 
4. 

Q .4Q .4 To whic h s tate of Ind ia  does  Reang tr ibe belong?To whic h s tate of Ind ia  does  Reang tr ibe belong?
A nsA ns 1. Sikkim

2. Madhya Pradesh
3. Tripura
4. Rajasthan

Q . 5Q . 5
A nsA ns 1. 

2. 
3. 
4. 

Q .6Q .6 Who among the fo l lowing have the author ity  to  dec lare any  area in the c ountry  as  S c hedule A rea?Who among the fo l lowing have the author ity  to  dec lare any  area in the c ountry  as  S c hedule A rea?
A nsA ns 1. President of India

2. Chief Justice of India
3. Chairman of the Commission for SCs
4. Prime Minister of India

Q .7Q .7 Who has  been appointed as  the firs t  E xec utive Direc tor  of  the Fund for  Res ponding to  L os s  and Damage,  whic h wasWho has  been appointed as  the firs t  E xec utive Direc tor  of  the Fund for  Res ponding to  L os s  and Damage,  whic h was
c reated to  s upport  c ountr ies  affec ted by  c l imate d is as ters?c reated to  s upport  c ountr ies  affec ted by  c l imate d is as ters?

A nsA ns 1. Richard Sherman
2. Ibrahima Cheikh Diong
3. Simon Stiell
4. Selwin Hart
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Q .8Q .8 When was  the G overnment of Ind ia  A c t  pas s ed by  the Br it is h,  whic h ended the rule of  the E as t  Ind ia  C ompany  inWhen was  the G overnment of Ind ia  A c t  pas s ed by  the Br it is h,  whic h ended the rule of  the E as t  Ind ia  C ompany  in
India?India?

A nsA ns 1. 1859
2. 1919
3. 1857
4. 1858

Q .9Q .9 Whic h of the fo l lowing C ons t itut ional  A mendment A c ts  added a new Fundamental  Duty  whic h reads ,  ' I t  s hal l  be theWhic h of the fo l lowing C ons t itut ional  A mendment A c ts  added a new Fundamental  Duty  whic h reads ,  ' I t  s hal l  be the
duty  of every  c it izen of Ind ia  who is  a  parent or  guardian to  provide opportunit ies  for  educ at ion to  their  c hi ld  orduty  of every  c it izen of Ind ia  who is  a  parent or  guardian to  provide opportunit ies  for  educ at ion to  their  c hi ld  or
ward between the age of s ix  and fourteen y ears '?ward between the age of s ix  and fourteen y ears '?

A nsA ns 1. 93rd

2. 96th

3. 86th

4. 103rd

Q .1 0Q .1 0 In whic h of the fo l lowing s tages  does  the M inis ter  des ire to  introduce a B i l l  and give a  wr itten notice for  it?In whic h of the fo l lowing s tages  does  the M inis ter  des ire to  introduce a B i l l  and give a  wr itten notice for  it?
A nsA ns 1. Final Reading

2. Second Reading
3. First Reading
4. Third Reading

Q .1 1Q .1 1 Who approves  the Fair  and Remunerat ive Pr ice ( FRP)  of  s ugarc ane in Ind ia?Who approves  the Fair  and Remunerat ive Pr ice ( FRP)  of  s ugarc ane in Ind ia?
A nsA ns 1. Food Corporation of India

2. Cabinet Committee on Economic Affair
3. Ministry of Agriculture and Farmers' Welfare
4. Commission for Agricultural Costs and Price

Q .1 2Q .1 2

A nsA ns 1. a) i, b) ii, c) iii, d) iv
2. a) iii, b) iv, c) i, d) ii
3. a) ii, b) i, c) iv, d) iii
4. a) i, b) iii, c) ii, d) iv

Q .1 3Q .1 3 Narendra M odi  was  the C hief M inis ter  of  whic h s tate when he bec ame the Pr ime M inis ter  in M ay  2 0 1 4 ?Narendra M odi  was  the C hief M inis ter  of  whic h s tate when he bec ame the Pr ime M inis ter  in M ay  2 0 1 4 ?
A nsA ns 1. Gujarat

2. Madhya Pradesh
3. Maharashtra
4. Uttar Pradesh

Q .1 4Q .1 4 Whic h pol it ic al  party  s ec ured a s ignific ant major ity  in the 2 0 24  United Kingdom general  elec t ions?Whic h pol it ic al  party  s ec ured a s ignific ant major ity  in the 2 0 24  United Kingdom general  elec t ions?
A nsA ns 1. Republican Party

2. Liberal Democrats Party
3. Conservative Party
4. Labour Party
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Q .1 5Q .1 5 In December 1 92 9,  under  the pres idenc y  of Jawahar la l  Nehru,  the ______ C ongres s  formal is ed the demand of ‘PurnaIn December 1 92 9,  under  the pres idenc y  of Jawahar la l  Nehru,  the ______ C ongres s  formal is ed the demand of ‘Purna
S waraj ’ or  ful l  independence for  Ind ia .S waraj ’ or  ful l  independence for  Ind ia .

A nsA ns 1. Nagpur
2. Surat
3. Calcutta
4. Lahore

Q .1 6Q .1 6 The Tr ipart ite Treaty  was  s igned between the Br it is h E as t  Ind ia  C ompany ,  S hah S huja ,  and M aharaja  Ranj it  S ingh inThe Tr ipart ite Treaty  was  s igned between the Br it is h E as t  Ind ia  C ompany ,  S hah S huja ,  and M aharaja  Ranj it  S ingh in
_________ ._________ .

A nsA ns 1. September 1838
2. June 1838
3. July 1838
4. August 1838

Q .1 7Q .1 7 Whic h of the fo l lowing dy nas t ies '  rule over  the Delhi  S ultanate began in 1 4 1 4  and ended in 1 4 51 ?Whic h of the fo l lowing dy nas t ies '  rule over  the Delhi  S ultanate began in 1 4 1 4  and ended in 1 4 51 ?
A nsA ns 1. Khalji Dynasty

2. Sayyid Dynasty
3. Lodi Dynasty
4. Tughlaq Dynasty

Q .1 8Q .1 8 A t the World  Bank  L and C onference 2 0 2 5,  why  was  India  rec ognis ed as  a  C ountry  C hampion?A t the World  Bank  L and C onference 2 0 2 5,  why  was  India  rec ognis ed as  a  C ountry  C hampion?
A nsA ns 1. For completing nationwide land redistribution to rural poor

2. For promoting forest-based tribal livelihoods through GIS
3. For pioneering digital land governance via schemes like SVAMITVA
4. For launching Smart City reforms through World Bank loans

Q .1 9Q .1 9 In whic h of the fo l lowing s tates  is  blac k  s o i l  found?In whic h of the fo l lowing s tates  is  blac k  s o i l  found?
A nsA ns 1. Himachal Pradesh

2. West Bengal
3. Uttar Pradesh
4. Maharashtra

Q .2 0Q .2 0 Whic h two organis at ions  jo int ly  c onduc ted 'E xerc is e Raahat '  to  s trengthen India’s  d is as ter  res pons e c apabi l it ies?Whic h two organis at ions  jo int ly  c onduc ted 'E xerc is e Raahat '  to  s trengthen India’s  d is as ter  res pons e c apabi l it ies?
A nsA ns 1. Indian Air Force and National Disaster Response Force (NDRF)

2. Indian Army and Central Reserve Police Force (CRPF)
3. Indian Army and National Disaster Response Force (NDRF)
4. National Disaster Management Authority and Indian Navy

Q .2 1Q .2 1 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ightRefer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight
only .only .
( L eft  end)  C  X  V  E  S  H M  N U F Z  M  H S  E  V  X  C  ( Right end)( L eft  end)  C  X  V  E  S  H M  N U F Z  M  H S  E  V  X  C  ( Right end)
Whic h letter  is  fifth to  the r ight  of the s eventh letter  from the r ight  end in the above s er ies?Whic h letter  is  fifth to  the r ight  of the s eventh letter  from the r ight  end in the above s er ies?

A nsA ns 1. M
2. U
3. X
4. H
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Q .2 2Q .2 2 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘× ‘  are interc hanged and ‘−’ andWhat wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘× ‘  are interc hanged and ‘−’ and
‘÷ ’ are interc hanged?‘÷ ’ are interc hanged?
1 4  ×  4  + 6  ÷  3 5 − 7  = ?1 4  ×  4  + 6  ÷  3 5 − 7  = ?

A nsA ns 1. 33
2. 28
3. 38
4. 35

Q .2 3Q .2 3 S elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figure given below to  c omplete the pattern.S elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figure given below to  c omplete the pattern.

A nsA ns 1. 

2. 

3. 

4. 

Q .24Q .24 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 471 683 2 ,  how many  d igits  wi l lI f  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 471 683 2 ,  how many  d igits  wi l l
appear  more than once in the new number thus  formed?appear  more than once in the new number thus  formed?

A nsA ns 1. One
2. Four
3. Two
4. Three

Q .2 5Q .2 5 B  is  the father  of C .  Q  is  the s on of P.  C  is  the s is ter  of  M .  L  is  marr ied  to  Q .  P  is  the wife of M .  How is  M  related toB  is  the father  of C .  Q  is  the s on of P.  C  is  the s is ter  of  M .  L  is  marr ied  to  Q .  P  is  the wife of M .  How is  M  related to
L ?L ?

A nsA ns 1. Wife’s father
2. Husband’s father 
3. Father’s sister
4. Wife’s brother 

Q .2 6Q .2 6 G TBD is  related to  IV DF in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  O BJL  is  related toG TBD is  related to  IV DF in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  O BJL  is  related to
Q DL N.  To whic h of the given options  is  UHPR related ,  fo l lowing the s ame logic ?Q DL N.  To whic h of the given options  is  UHPR related ,  fo l lowing the s ame logic ?

A nsA ns 1. WJRT
2. WRGY
3. WRTY
4. WGYU

Q .2 7Q .2 7 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘× ’ and ‘−’ are interc hanged and ‘÷ ’ andWhat wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘× ’ and ‘−’ are interc hanged and ‘÷ ’ and
‘+’ are interc hanged?‘+’ are interc hanged?
1 92  + 6  − 1 3  ÷  3 3  ×  1 1  =  ?1 92  + 6  − 1 3  ÷  3 3  ×  1 1  =  ?

A nsA ns 1. 432
2. 426
3. 429
4. 438
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Q .2 8Q .2 8 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

( 3,  24 ,  1 6)( 3,  24 ,  1 6)
( 2 ,  1 8 ,  1 1 )( 2 ,  1 8 ,  1 1 )

A nsA ns 1. (6, 16, 9)
2. (9, 21, 7)
3. (1, 56, 3)
4. (2, 12, 3)

Q .2 9Q .2 9 2 2  is  related to  472  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  4  is  related to  4 .  To  whic h of the given2 2  is  related to  472  fo l lowing a certain logic .  Fo l lowing the s ame logic ,  4  is  related to  4 .  To  whic h of the given
options  is  1 8  related ,  fo l lowing the s ame logic ?options  is  1 8  related ,  fo l lowing the s ame logic ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their
c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.
Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )Break ing down 1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

A nsA ns 1. 172
2. 181
3. 312
4. 169

Q .3 0Q .3 0 S ix  people,  T,  U,  V,  W,  H  and I ,  are s itt ing around a c irc ular  table fac ing the centre of the table.  O nly  two people s itS ix  people,  T,  U,  V,  W,  H  and I ,  are s itt ing around a c irc ular  table fac ing the centre of the table.  O nly  two people s it
between T  and I  when c ounted from the left  of  I .  V  s its  third  to  the left  of  U.  H  s its  to  the immediate r ight  of U.  Ibetween T  and I  when c ounted from the left  of  I .  V  s its  third  to  the left  of  U.  H  s its  to  the immediate r ight  of U.  I
s its  s ec ond to  the left  of  H .  How many  people s it  between W and V  when c ounted from the r ight  of W?s its  s ec ond to  the left  of  H .  How many  people s it  between W and V  when c ounted from the r ight  of W?

A nsA ns 1. Three
2. Two
3. One
4. Four

Q .3 1Q .3 1 E ac h vowel  in the word S PE A KE R is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  orderE ac h vowel  in the word S PE A KE R is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  order
and eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  Whic h ofand eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  Whic h of
the fo l lowing letters  wi l l  appear  exac t ly  twice in the group of letters  thus  formed?the fo l lowing letters  wi l l  appear  exac t ly  twice in the group of letters  thus  formed?

A nsA ns 1. S
2. F
3. B
4. O

Q .3 2Q .3 2 E ac h vowel  in the word ‘G A RDE N’ is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  orderE ac h vowel  in the word ‘G A RDE N’ is  c hanged to  the letter  immediately  fo l lowing it  in the E ngl is h a lphabetic al  order
and eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  A l l  theand eac h c ons onant is  c hanged to  the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  A l l  the
letters  thus  formed are then arranged in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be onletters  thus  formed are then arranged in the E ngl is h a lphabetic al  order.  Whic h of the fo l lowing letters  wi l l  be on
the third  pos it ion from the left  of  the new group of letters  thus  formed?the third  pos it ion from the left  of  the new group of letters  thus  formed?

A nsA ns 1. M
2. F
3. Q
4. B
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Q .3 3Q .3 3 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low theS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs  given below.  Both pairs  fo l low the
s ame pattern.s ame pattern.
ZC K :  WG JZC K :  WG J
L IT  :  IM SL IT  :  IM S

A nsA ns 1. DOE : KMC
2. MOB : JSA
3. COD : MFJ
4. MOC : FMK

Q .3 4Q .3 4 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

4 1 2  4 1 2  4 0 1  4 0 1  4 1 4  4 1 4  4 0 3  4 0 3  4 1 6 4 1 6  ??
A nsA ns 1. 407

2. 411
3. 403
4. 405

Q .3 5Q .3 5 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO TThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a group.  Whic h word- pair  DO E S  NO T
belong to  that  group?belong to  that  group?

( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not  be related to  eac h other  bas ed on
the number of letters  /number of c ons onants/vowels  in the word . )the number of letters  /number of c ons onants/vowels  in the word . )

A nsA ns 1. Ants : Colony
2. Lions : Pride
3. Geese : Gaggle
4. Fish : Pack

Q .3 6Q .3 6 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  

4  4  8  8  24  24  4 8 4 8 1 4 4  1 4 4  ??
A nsA ns 1. 

2. 
3. 
4. 

Q .3 7Q .3 7 S ix  people,  G ,  H ,  I ,  J ,  S  and T,  are s itt ing around a c irc ular  table,  fac ing the centre of the table.  I  s its  fourth to  theS ix  people,  G ,  H ,  I ,  J ,  S  and T,  are s itt ing around a c irc ular  table,  fac ing the centre of the table.  I  s its  fourth to  the
r ight of J .  O nly  two people s it  between S  and G  when c ounted from the left  of  S.  I  s its  third  to  the left  of  H .  H  s itsr ight  of J .  O nly  two people s it  between S  and G  when c ounted from the left  of  S.  I  s its  third  to  the left  of  H .  H  s its
immediately  between J  and G .  How many  people s it  between S  and T  when c ounted from the r ight  of S ?immediately  between J  and G .  How many  people s it  between S  and T  when c ounted from the r ight  of S ?

A nsA ns 1. Two
2. Three
3. One
4. None

Q .3 8Q .3 8 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  andBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and
thus  form a group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  thus  form a group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. ILG
2. GJF
3. EHC
4. CFA
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Q .3 9Q .3 9 Whic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern and relat ions hip fo l lowedWhic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern and relat ions hip fo l lowed
between the letter- c lus ter  pair  on the left  s ide of : :  is  the s ame as  that  on the r ight  s ide of : : ?between the letter- c lus ter  pair  on the left  s ide of : :  is  the s ame as  that  on the r ight  s ide of : : ?

# :  NPO  : :  IKJ  :  %# :  NPO  : :  IKJ  :  %
A nsA ns 1. # = QSQ, % = EGG

2. # = QSR, % = FGH
3. # = QSR, % = FHG
4. # = QUT, % = FHG

Q .4 0Q .4 0 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion.Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion.

( L eft)  Z  X  T  R K J  L  M  Q  P  N V  W F G  H I  L  O  P  W S  N Z  C  B  A  K ( Right)( L eft)  Z  X  T  R K J  L  M  Q  P  N V  W F G  H I  L  O  P  W S  N Z C  B  A  K ( Right)

How many  c ons onants  are pres ent acc ording to  E ngl is h a lphabet between the fourth letter  from the r ight  and theHow many  c ons onants  are pres ent acc ording to  E ngl is h a lphabet between the fourth letter  from the r ight  and the
third  letter  from the left?third  letter  from the left?

A nsA ns 1. Eight
2. Twelve
3. Thirteen
4. Nine

Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
He worked ___ to  c omplete the projec t  on t ime.He worked ___ to  c omplete the projec t  on t ime.

A nsA ns 1. hardness
2. hard
3. hardly
4. hards

Q .4 2Q .4 2 S elec t  the mos t appropr iate options  to  fil l  in the blanks .S elec t  the mos t appropr iate options  to  fil l  in the blanks .

___________ he is  very  s mart  ____ he is  too ins ightful .___________ he is  very  s mart  ____ he is  too ins ightful .
A nsA ns 1. Neither; nor

2. Either; or
3. Not only; but also
4. As; yet

Q .43Q .43 S elec t  the mos t appropr iate meaning of the given word .S elec t  the mos t appropr iate meaning of the given word .

S hardS hard
A nsA ns 1. Union

2. Whole
3. Fragment
4. Expansion

Q .4 4Q .4 4 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.
L et  the gras s  grow under  one’s  feetL et  the gras s  grow under  one’s  feet

A nsA ns 1. To delay taking action
2. To take a firm stand
3. To work tirelessly
4. To create unnecessary problems

Section : General English and Comprehension
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Q .4 5Q .4 5 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .

A  pers on who makes  mapsA  pers on who makes  maps
A nsA ns 1. Astronomer

2. Geologist
3. Physicist
4. Cartographer

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Roman Empire can broadly be divided into two phases, ‘early’ and ‘late’, divided by the third century as a sort of historical
watershed between them. In other words, the whole period down to the main part of the third century can be called the ‘early
empire’, and the period after that the ‘late empire’. The Roman Empire was a mosaic of territories and cultures that were chiefly
bound together by a common system of government. Many languages were spoken in the empire, but for the purposes of
administration, Latin and Greek were the most widely used languages. The upper classes of the east spoke and wrote in Greek,
those of the west in Latin, and the boundary between these broad language areas ran somewhere across the middle of the
Mediterranean, between the African provinces of Tripolitania (which was Latin speaking) and Cyrenaica (Greek-speaking). All
those who lived in the empire were subjects of a single ruler, the emperor, regardless of where they lived and what language they
spoke.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 Whic h pair  of  terms  is  us ed in the pas s age to  denote the his tor ic al  d iv is ion of the Roman E mpire?Whic h pair  of  terms  is  us ed in the pas s age to  denote the his tor ic al  d iv is ion of the Roman E mpire?
A nsA ns 1. Latin and Greek

2. Prehistoric and Historic
3. Ancient and Modern
4. Early and Late

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Roman Empire can broadly be divided into two phases, ‘early’ and ‘late’, divided by the third century as a sort of historical
watershed between them. In other words, the whole period down to the main part of the third century can be called the ‘early
empire’, and the period after that the ‘late empire’. The Roman Empire was a mosaic of territories and cultures that were chiefly
bound together by a common system of government. Many languages were spoken in the empire, but for the purposes of
administration, Latin and Greek were the most widely used languages. The upper classes of the east spoke and wrote in Greek,
those of the west in Latin, and the boundary between these broad language areas ran somewhere across the middle of the
Mediterranean, between the African provinces of Tripolitania (which was Latin speaking) and Cyrenaica (Greek-speaking). All
those who lived in the empire were subjects of a single ruler, the emperor, regardless of where they lived and what language they
spoke.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 A cc ording to  the pas s age,  whic h languages  were pr imar i ly  us ed for  adminis trat ion in the Roman E mpire?A cc ording to  the pas s age,  whic h languages  were pr imar i ly  us ed for  adminis trat ion in the Roman E mpire?
A nsA ns 1. Arabic and Hebrew

2. Parthian and Sasanian
3. Latin and Greek
4. Latin and French
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Roman Empire can broadly be divided into two phases, ‘early’ and ‘late’, divided by the third century as a sort of historical
watershed between them. In other words, the whole period down to the main part of the third century can be called the ‘early
empire’, and the period after that the ‘late empire’. The Roman Empire was a mosaic of territories and cultures that were chiefly
bound together by a common system of government. Many languages were spoken in the empire, but for the purposes of
administration, Latin and Greek were the most widely used languages. The upper classes of the east spoke and wrote in Greek,
those of the west in Latin, and the boundary between these broad language areas ran somewhere across the middle of the
Mediterranean, between the African provinces of Tripolitania (which was Latin speaking) and Cyrenaica (Greek-speaking). All
those who lived in the empire were subjects of a single ruler, the emperor, regardless of where they lived and what language they
spoke.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 Whic h of the fo l lowing is  an A NTO NYM  for  the given word as  us ed in the pas s age?Whic h of the fo l lowing is  an A NTO NYM  for  the given word as  us ed in the pas s age?

BoundBound
A nsA ns 1. Untied

2. Varied
3. Multifaceted
4. Certain

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Roman Empire can broadly be divided into two phases, ‘early’ and ‘late’, divided by the third century as a sort of historical
watershed between them. In other words, the whole period down to the main part of the third century can be called the ‘early
empire’, and the period after that the ‘late empire’. The Roman Empire was a mosaic of territories and cultures that were chiefly
bound together by a common system of government. Many languages were spoken in the empire, but for the purposes of
administration, Latin and Greek were the most widely used languages. The upper classes of the east spoke and wrote in Greek,
those of the west in Latin, and the boundary between these broad language areas ran somewhere across the middle of the
Mediterranean, between the African provinces of Tripolitania (which was Latin speaking) and Cyrenaica (Greek-speaking). All
those who lived in the empire were subjects of a single ruler, the emperor, regardless of where they lived and what language they
spoke.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 Whic h of the fo l lowing c an be us ed as  a  s uitable t it le for  the given pas s age?Whic h of the fo l lowing c an be us ed as  a  s uitable t it le for  the given pas s age?
A nsA ns 1. The Roman Empire's administrative languages

            
2 . Linguistic and Cultural Dynamics of the Roman Empire
3. The geographical divisions of the Roman Empire
4. Class Structure in the Roman Empire
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

The Roman Empire can broadly be divided into two phases, ‘early’ and ‘late’, divided by the third century as a sort of historical
watershed between them. In other words, the whole period down to the main part of the third century can be called the ‘early
empire’, and the period after that the ‘late empire’. The Roman Empire was a mosaic of territories and cultures that were chiefly
bound together by a common system of government. Many languages were spoken in the empire, but for the purposes of
administration, Latin and Greek were the most widely used languages. The upper classes of the east spoke and wrote in Greek,
those of the west in Latin, and the boundary between these broad language areas ran somewhere across the middle of the
Mediterranean, between the African provinces of Tripolitania (which was Latin speaking) and Cyrenaica (Greek-speaking). All
those who lived in the empire were subjects of a single ruler, the emperor, regardless of where they lived and what language they
spoke.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 Whic h of the fo l lowing is  a  s ummary  of the pas s age?Whic h of the fo l lowing is  a  s ummary  of the pas s age?
A nsA ns 1. The Roman Empire was united under a common system of government despite cultural and linguistic diversity.

2. The Roman Empire underwent distinct phases known as early and late periods.
3. The Roman Empire's administrative language was primarily Greek but those who spoke Latin were also considered as the

subjects of the empire.
4. The Roman Empire was linguistically divided into Latin and Greek speaking regions.

Q . 51Q . 51 ‘‘ असुरअसुर ’ ’ काका   प य` यवा चीप य` यवा ची   शeशe   हो गाहो गा --
A nsA ns 1. देवता

2. देव
3. दैm
4. सुर

Q . 52Q . 52 '' अंतअंत   भलाभला   सोसो   सबसब   भलाभला '  '  लो को rsलो को rs   काका   सहीसही   अथuअथu   हो गाहो गा --
A nsA ns 1. अपनी कुशल देखो

2. अभी कसर है
3. पxरणाम अ{ा हो जाए तो सब कुछ अ{ा माना जाता है
4. �बना बात झगड़ा करना

Q . 53Q . 53 '' मुकु लमुकु ल '  '  िक सकािक सका   प य` यवा चीप य` यवा ची   हैहै ??
A nsA ns 1. कूल

2. मुलायम
3. अलक
4. कली

Q . 54Q . 54 '' अजग रअजग र   क रेक रे   नन   चा क र�चा क र�   प ंछ�प ंछ�   क रेक रे   नन   का मका म '  '  लो को rsलो को rs   काका   अथuअथu   �ा�ा   हैहै --
A nsA ns 1. अजगर और पंछ� आलसी ह�।

2. ई�र सबक� अव�कताएं पूर�  करता है।
3. अजगर और पंछ� एक दूसरे के ��तकूल ह�।
4. अजगर एक सु� जानवर है।

Q . 55Q . 55 उ �चतउ �चत   �वशेष ण�वशेष ण   शeशe   चुनक रचुनक र   xर sxर s   �ा न�ा न   भर�भर�
वह� . . . . . . . . . . . . . . . . .लड़ केवह� . . . . . . . . . . . . . . . . .लड़ के   बैठेबैठे   ह�ह� ।।

A nsA ns 1. कोमल
2. दो
3. कोई
4. कैसा
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C omprehens ion:C omprehens ion:
��ुत ग��श को पढ़कर पूछे गए ��� के उ�र दी�जए :
'वतuमान युग म� �जस भीषणता के साथ जीवन-संघषu चल रहा है. उसम� वह �rs कभी भी �वजयी नह  हो सकता, जो चुपचाप बैठकर अ�तदीघuकाल तक सोचता-
�वचारता रहेगा। यह� तो वही िटक सकता है, �जसम� काफ� £ू�तu है, जो दूसर� को ढकेलकर आगे बढ़ सकता है। नह  तो जो उससे ताकतवर है उसे िकनारे ढकेल
देगा और आप आगे बढ़ जाएगा। अगर तुम इस जीवन म� कुछ करना चाहते हो , अगर तु¦� अपना जीवन सफल बनाना है, तो तु¦� �mु§¨म�त होना चा©हए, अपने
�नणuय पर ªढ़ रहना चा©हए और उसपर जमकर काम करना चा©हए। �जस �rs म� ये गुण पाए जाते ह�, उसम� अ« गुण� का समावेश भी रहता है। जीवन म� �वचलन के
अवसर आते ही रहते ह�, पर मनु¬ को ऐसी ®��तय� म� भी �वच�लत न होकर ®�त�¯ और अपनी धारणाओं पर िटके रहना होता है। संसार के सभी महान �rsय�
के �rs² म� हम यह वै�श³ पाते ह�।'

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 � �ुत� �ुत   ग �� शग �� श   क�क�   संर चनासंर चना   हैहै  - -
A nsA ns 1. का�ा´कता

2. �वचार�धान
3. �बंब�धान
4. भाव�धान

C omprehens ion:C omprehens ion:
��ुत ग��श को पढ़कर पूछे गए ��� के उ�र दी�जए :
'वतuमान युग म� �जस भीषणता के साथ जीवन-संघषu चल रहा है. उसम� वह �rs कभी भी �वजयी नह  हो सकता, जो चुपचाप बैठकर अ�तदीघuकाल तक सोचता-
�वचारता रहेगा। यह� तो वही िटक सकता है, �जसम� काफ� £ू�तu है, जो दूसर� को ढकेलकर आगे बढ़ सकता है। नह  तो जो उससे ताकतवर है उसे िकनारे ढकेल
देगा और आप आगे बढ़ जाएगा। अगर तुम इस जीवन म� कुछ करना चाहते हो , अगर तु¦� अपना जीवन सफल बनाना है, तो तु¦� �mु§¨म�त होना चा©हए, अपने
�नणuय पर ªढ़ रहना चा©हए और उसपर जमकर काम करना चा©हए। �जस �rs म� ये गुण पाए जाते ह�, उसम� अ« गुण� का समावेश भी रहता है। जीवन म� �वचलन के
अवसर आते ही रहते ह�, पर मनु¬ को ऐसी ®��तय� म� भी �वच�लत न होकर ®�त�¯ और अपनी धारणाओं पर िटके रहना होता है। संसार के सभी महान �rsय�
के �rs² म� हम यह वै�श³ पाते ह�।'

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 � �ुत� �ुत   उ µर णउ µर ण   म�म�  ' ' � mु§¨ म�त� mु§¨ म�त '  '  शeशe   काका   अथuअथu   हैहै  - -
A nsA ns 1. तुरत-फुरत

2. हा�जरजवाबी
3. �नपुण
4. कायuकुशल

C omprehens ion:C omprehens ion:
��ुत ग��श को पढ़कर पूछे गए ��� के उ�र दी�जए :
'वतuमान युग म� �जस भीषणता के साथ जीवन-संघषu चल रहा है. उसम� वह �rs कभी भी �वजयी नह  हो सकता, जो चुपचाप बैठकर अ�तदीघuकाल तक सोचता-
�वचारता रहेगा। यह� तो वही िटक सकता है, �जसम� काफ� £ू�तu है, जो दूसर� को ढकेलकर आगे बढ़ सकता है। नह  तो जो उससे ताकतवर है उसे िकनारे ढकेल
देगा और आप आगे बढ़ जाएगा। अगर तुम इस जीवन म� कुछ करना चाहते हो , अगर तु¦� अपना जीवन सफल बनाना है, तो तु¦� �mु§¨म�त होना चा©हए, अपने
�नणuय पर ªढ़ रहना चा©हए और उसपर जमकर काम करना चा©हए। �जस �rs म� ये गुण पाए जाते ह�, उसम� अ« गुण� का समावेश भी रहता है। जीवन म� �वचलन के
अवसर आते ही रहते ह�, पर मनु¬ को ऐसी ®��तय� म� भी �वच�लत न होकर ®�त�¯ और अपनी धारणाओं पर िटके रहना होता है। संसार के सभी महान �rsय�
के �rs² म� हम यह वै�श³ पाते ह�।'

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 � �ुत� �ुत   ग �� शग �� श   काका   के ¶ी यके ¶ी य   भा वभा व   हैहै  - -
A nsA ns 1. असफलता का वणuन

2. सफलता के कारक� क� पहचान
3. जीवन-संघषu का वणuन
4. उ�म का वणuन
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C omprehens ion:C omprehens ion:
��ुत ग��श को पढ़कर पूछे गए ��� के उ�र दी�जए :
'वतuमान युग म� �जस भीषणता के साथ जीवन-संघषu चल रहा है. उसम� वह �rs कभी भी �वजयी नह  हो सकता, जो चुपचाप बैठकर अ�तदीघuकाल तक सोचता-
�वचारता रहेगा। यह� तो वही िटक सकता है, �जसम� काफ� £ू�तu है, जो दूसर� को ढकेलकर आगे बढ़ सकता है। नह  तो जो उससे ताकतवर है उसे िकनारे ढकेल
देगा और आप आगे बढ़ जाएगा। अगर तुम इस जीवन म� कुछ करना चाहते हो , अगर तु¦� अपना जीवन सफल बनाना है, तो तु¦� �mु§¨म�त होना चा©हए, अपने
�नणuय पर ªढ़ रहना चा©हए और उसपर जमकर काम करना चा©हए। �जस �rs म� ये गुण पाए जाते ह�, उसम� अ« गुण� का समावेश भी रहता है। जीवन म� �वचलन के
अवसर आते ही रहते ह�, पर मनु¬ को ऐसी ®��तय� म� भी �वच�लत न होकर ®�त�¯ और अपनी धारणाओं पर िटके रहना होता है। संसार के सभी महान �rsय�
के �rs² म� हम यह वै�श³ पाते ह�।'

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 � �ुत� �ुत   ग �� शग �� श   केके   �लए�लए   उ प युsउ प युs   शी ष uकशी षuक   चुन�चुन�  - -
A nsA ns 1. �वजयी मनु¬

2. ि·याशील मनु¬
3. ग�तशील मनु¬
4. परा�जत मनु¬

C omprehens ion:C omprehens ion:
��ुत ग��श को पढ़कर पूछे गए ��� के उ�र दी�जए :
'वतuमान युग म� �जस भीषणता के साथ जीवन-संघषu चल रहा है. उसम� वह �rs कभी भी �वजयी नह  हो सकता, जो चुपचाप बैठकर अ�तदीघuकाल तक सोचता-
�वचारता रहेगा। यह� तो वही िटक सकता है, �जसम� काफ� £ू�तu है, जो दूसर� को ढकेलकर आगे बढ़ सकता है। नह  तो जो उससे ताकतवर है उसे िकनारे ढकेल
देगा और आप आगे बढ़ जाएगा। अगर तुम इस जीवन म� कुछ करना चाहते हो , अगर तु¦� अपना जीवन सफल बनाना है, तो तु¦� �mु§¨म�त होना चा©हए, अपने
�नणuय पर ªढ़ रहना चा©हए और उसपर जमकर काम करना चा©हए। �जस �rs म� ये गुण पाए जाते ह�, उसम� अ« गुण� का समावेश भी रहता है। जीवन म� �वचलन के
अवसर आते ही रहते ह�, पर मनु¬ को ऐसी ®��तय� म� भी �वच�लत न होकर ®�त�¯ और अपनी धारणाओं पर िटके रहना होता है। संसार के सभी महान �rsय�
के �rs² म� हम यह वै�श³ पाते ह�।'

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 � �ुत� �ुत   ग �� शग �� श   म�म�  ' ' £ू �त u£ू �त u '  '  शeशe   काका   अथuअथu   हैहै  - -
A nsA ns 1. आल¸

2. सु�ी
3. फुरती
4. उ�म

Q .61Q .61 What is  the purpos e of the c ompatibi l ity  c hec ker  when opening an o lder  M S  E xcel  file in a  newer  vers ion?What is  the purpos e of the c ompatibi l ity  c hec ker  when opening an o lder  M S  E xcel  file in a  newer  vers ion?
A nsA ns 1. To update the file format

2. To enable macros
3. To repair the file
4. To check for features not supported in older versions

Q .62Q .62 Whic h of the fo l lowing panels  is  us ed for  c hanging the s y s tem s ett ings  in the Windows  operat ing s y s tem?Whic h of the fo l lowing panels  is  us ed for  c hanging the s y s tem s ett ings  in the Windows  operat ing s y s tem?
A nsA ns 1. Window Panel

2. Hardware Panel
3. System Panel
4. Control Panel

Q .63Q .63 How c an y ou acces s  the C ontrol  Panel  in Windows  1 0 ?How c an y ou acces s  the C ontrol  Panel  in Windows  1 0 ?
A nsA ns 1. Open the Start Menu and select Control Panel

2. Right-click on the desktop
3. Press Ctrl + Alt + Delete
4. Type 'Control Panel' in the search box and select it

Section : Basic Knowledge of Computer
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Q .64Q .64 In M S  PowerPoint ,  the feature that  a l lows  a us er  to  c ontro l  the s ize and proport ions  of a  graphic  or  objec t  ins ertedIn M S  PowerPoint ,  the feature that  a l lows  a us er  to  c ontro l  the s ize and proport ions  of a  graphic  or  objec t  ins erted
into a  s l ide is  c al led :into  a  s l ide is  c al led :

A nsA ns 1. Clipping
2. Resizing and Scaling
3. Cropping
4. Stretching

Q .65Q .65 Why  is  c y ber  s ec ur ity  c ruc ia l  for  modern organis at ions?Why  is  c y ber  s ec ur ity  c ruc ia l  for  modern organis at ions?
A nsA ns 1. To protect sensitive information from unauthorised access and cyber attacks

2. To increase the number of software applications used within the organisation
3. To ensure that their websites load faster
4. To reduce the need for physical security measures

Q .66Q .66 In M S  Word ,  when v iewing a doc ument in Pr int  Preview,  y ou notice that  the text  extends  bey ond the pr intable areaIn M S  Word ,  when v iewing a doc ument in Pr int  Preview,  y ou notice that  the text  extends  bey ond the pr intable area
of the page.  Whic h of the fo l lowing ac t ions  would  help y ou c orrec t  this  is s ue?of the page.  Whic h of the fo l lowing ac t ions  would  help y ou c orrec t  this  is s ue?

A nsA ns 1. Increase the font size
2. Decrease the page margins
3. Use the 'Shrink One Page' option
4. Change the page orientation to portrait

Q .67Q .67
A nsA ns 1. 

2. 
3. 
4. 

Q .68Q .68 Whic h protoc ol  is  c ommonly  us ed for  s ec ure c ommunic at ion over  the web?Whic h protoc ol  is  c ommonly  us ed for  s ec ure c ommunic at ion over  the web?
A nsA ns 1. HTTPS

2. HTTS
3. FTP
4. SMTP

Q .69Q .69 M ic ros oft  Windows  is  a  ty pe of a/an ______ .M ic ros oft  Windows  is  a  ty pe of a/an ______ .
A nsA ns 1. word processor

2. operating system
3. spreadsheet application
4. BIOS

Q .70Q .70
A nsA ns 1. 

2. 
3. 
4. 

Q .71Q .71 Whic h of the fo l lowing ut i l it ies  in Windows  operat ing s y s tem al lows  us ers  to  add or  remove Windows  c omponentsWhic h of the fo l lowing ut i l it ies  in Windows  operat ing s y s tem al lows  us ers  to  add or  remove Windows  c omponents
and features  us ing a c ommand- l ine interface?and features  us ing a c ommand- l ine interface?

A nsA ns 1. Command Prompt
2. Device Manager
3. Control Panel
4. Task Manager
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Q .72Q .72
A nsA ns 1. 

2. 

3. 

4. 

Q .73Q .73 In M S  Word ,  y ou want to  move a paragraph from one part  of  a  doc ument to  another.  What is  the c orrec t  s equenceIn M S  Word ,  y ou want to  move a paragraph from one part  of  a  doc ument to  another.  What is  the c orrec t  s equence
of ac t ions  to  ac hieve this  us ing the C ut ,  C opy ,  and Pas te c ommands?of ac t ions  to  ac hieve this  us ing the C ut ,  C opy ,  and Pas te c ommands?

A nsA ns 1. Highlight the paragraph, go to the Insert tab, click Cut, move to the new location, and click Paste.
2. Highlight the paragraph, go to the Home tab, click Copy, move to the new location, and click Paste.
3. Highlight the paragraph, go to the Home tab, click Cut, move to the new location, and click Paste.
4. Highlight the paragraph, go to the Home tab, click Cut, move to the new location, and then click Copy.

Q .74Q .74 What func t ion does  an email  mes s age's  'Bcc : '  header  s erve?What func t ion does  an email  mes s age's  'Bcc : '  header  s erve?
A nsA ns 1. To include attachments

2. To indicate the recipient
3. To indicate the sender
4. To hide the recipient from other recipients

Q .75Q .75 A fter  s elec t ing a template and c reat ing a new M S  PowerPoint  2 0 1 0  pres entat ion,  how c an y ou modify  the templateA fter  s elec t ing a template and c reat ing a new M S  PowerPoint  2 0 1 0  pres entat ion,  how c an y ou modify  the template
des ign?des ign?

A nsA ns 1. Change the background colour only.
2. Apply a different theme or modify elements in the Design tab.
3. Delete all slides and start over.
4. Edit individual slide content only.

Q .76Q .76 How to  turn on/off paragraph marks  in an M S  Word doc ument?How to  turn on/off paragraph marks  in an M S  Word doc ument?
A nsA ns 1. Go to File -> Options -> Proofing -> Paragraph Marks -> Tick or Untick

2. Go to File -> Options -> Display -> Paragraph Marks -> Tick or Untick
3. Go to File -> Options -> Language -> Paragraph Marks -> Tick or Untick
4. Go to File -> Options -> General -> Paragraph Marks -> Tick or Untick

Q .77Q .77 Whic h of the fo l lowing acc urately  des c r ibes  the purpos e of the ' robots . txt '  file in the c ontext  of  the World  WideWhic h of the fo l lowing acc urately  des c r ibes  the purpos e of the ' robots . txt '  file in the c ontext  of  the World  Wide
Web and webs ites?Web and webs ites?

A nsA ns 1. It instructs web crawlers and search engines about which pages or sections of the website should not be crawled or
indexed.

2. It ensures that the website is compatible with different browsers and devices by including necessary compatibility scripts.
3. It is used to store the website's source code and content for backup purposes.
4. It provides metadata about the website, such as title and description, to search engines.

Q .78Q .78 Whic h internet port  is  ty pic al ly  us ed for  S M TP operat ions?Whic h internet port  is  ty pic al ly  us ed for  S M TP operat ions?
A nsA ns 1. Port 25

2. Port 80
3. Port 110
4. Port 143
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Q .79Q .79 Whic h extens ion is  us ed for  s av ing a M ic ros oft  Word doc ument?Whic h extens ion is  us ed for  s av ing a M ic ros oft  Word doc ument?
A nsA ns 1. .png

2. .pdf
3. .txt
4. .docx

Q .80Q .80 What is  a  Key logger?What is  a  Key logger?
A nsA ns 1. A program that encrypts all keyboard inputs for security

2. A software that helps in speeding up typing speed
3. A tool used to log into secure websites without a password
4. A hardware or software tool that records keystrokes made on a keyboard

Q .81Q .81 The value ofThe value of

A nsA ns 1. 703
2. 699
3. 702
4. 696

Q .82Q .82 2  t imes  the pres ent age of D iks ha is  1 2  y ears  more than 2  t imes  the pres ent age of A mit ,  and 9  t imes  the pres ent2  t imes  the pres ent age of D iks ha is  1 2  y ears  more than 2  t imes  the pres ent age of A mit ,  and 9  t imes  the pres ent
age of A mit  is  1 1  y ears  les s  than 8  t imes  the pres ent age of D iks ha .  The s um of the pres ent ages  ( in y ears)  of  D iks haage of A mit  is  1 1  y ears  les s  than 8  t imes  the pres ent age of D iks ha .  The s um of the pres ent ages  ( in y ears)  of  D iks ha
and A mit  is :and A mit  is :

A nsA ns 1. 79
2. 82
3. 77
4. 80

Q .83Q .83 Nit in s el ls  two art ic les  for  ₹4 ,963  eac h with no profit ,  no  los s  in the ent ire trans ac t ion.  I f  one art ic le was  s o ld  at  aNit in s el ls  two art ic les  for  ₹4 ,963  eac h with no profit ,  no  los s  in the ent ire trans ac t ion.  I f  one art ic le was  s o ld  at  a
gain of 75%, then the other  art ic le is  s o ld  at  a  los s  of :gain of 75%, then the other  art ic le is  s o ld  at  a  los s  of :

A nsA ns 1. 28%
2. 32%
3. 30%
4. 29%

Q .84Q .84 John gave 4 0 % of his  s alary  to  his  wife.  O ut of the remaining money ,  he a ls o  gave 1 0 % to  his  s on and another  1 0 %John gave 4 0 % of his  s alary  to  his  wife.  O ut of the remaining money ,  he a ls o  gave 1 0 % to  his  s on and another  1 0 %
to his  daughter.  He depos ited the remaining amount ,  whic h was  ₹1 9 ,2 0 0 ,  in the bank .  Find his  s alary .to  his  daughter.  He depos ited the remaining amount ,  whic h was  ₹1 9 ,2 0 0 ,  in the bank .  Find his  s alary .

A nsA ns 1. ₹40,000
2. ₹42,000
3. ₹45,000
4. ₹30,000

Q .85Q .85

A nsA ns 1. 5
2. 25
3. 125
4. 625

Section : Quantitative Aptitude
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Q .86Q .86 The average of the firs t  2 1  natural  numbers  is :The average of the firs t  2 1  natural  numbers  is :
A nsA ns 1. 11

2. 10.5
3. 11.5
4. 12

Q .87Q .87 P c an finis h a  work  in 2 0  day s ,  Q  in 1 0  day s  and R in 1 6  day s .  Q  and R s tarted doing the work ,  but  left  after  4  day s .P  c an finis h a  work  in 2 0  day s ,  Q  in 1 0  day s  and R in 1 6  day s .  Q  and R s tarted doing the work ,  but  left  after  4  day s .
The remaining work  was  done by  P  in :The remaining work  was  done by  P  in :

A nsA ns 1. 7 days
2. 6 days
3. 8 days
4. 9 days

Q .88Q .88 A  s hopkeeper  marks  two items  at  a  total  of  ₹2 5,4 4 1 .  He s el ls  one item at  s ucces s ive d is c ounts  of 2 5% and 1 0 %, andA  s hopkeeper  marks  two items  at  a  total  of  ₹2 5,4 4 1 .  He s el ls  one item at  s ucces s ive d is c ounts  of 2 5% and 1 0 %, and
the other  item at  s ucces s ive d is c ounts  of 3 0 % and 2 0 % on their  res pec t ive marked pr ices .  I f  the s el l ing pr ice ofthe other  item at  s ucces s ive d is c ounts  of 3 0 % and 2 0 % on their  res pec t ive marked pr ices .  I f  the s el l ing pr ice of
both the items  is  the s ame,  the marked pr ice of the firs t  item is :both the items  is  the s ame,  the marked pr ice of the firs t  item is :

A nsA ns 1. ₹11,536
2. ₹15,246
3. ₹13,466
4. ₹14,536

Q .89Q .89 The number of voters  in a  v i l lage dec reas ed from 1 0 ,0 0 0  to  850 0 .  Find the percentage dec reas e in the number ofThe number of voters  in a  v i l lage dec reas ed from 1 0 ,0 0 0  to  850 0 .  Find the percentage dec reas e in the number of
voters .voters .

A nsA ns 1. 18%
2. 21%
3. 17.65%
4. 15%

Q .90Q .90

A nsA ns 1. 5
2. 7
3. 12
4. 2

Q .91Q .91 What is  the average s peed of a  truc k  whic h c overs  half  the d is tance with a  s peed of 3 0  km/ hr  and the other  halfWhat is  the average s peed of a  truc k  whic h c overs  half  the d is tance with a  s peed of 3 0  km/ hr  and the other  half
with a  s peed of 2 0  km/ hr?with a  s peed of 2 0  km/ hr?

A nsA ns 1. 25 km/hr
2. 24 km/hr
3. 23 km/hr
4. 29 km/hr

Q .92Q .92 The s el l ing pr ice of 2 0  books  is  equal  to  the c os t  pr ice of 3 2  books .  F ind the los s  or  gain percentage.The s el l ing pr ice of 2 0  books  is  equal  to  the c os t  pr ice of 3 2  books .  F ind the los s  or  gain percentage.
A nsA ns 1. 

2. 

3. 

4. 
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1. 900

2. 895
3. 935
4. 925

Q .94Q .94 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 70  − 1 2 ) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 70  − 1 2 ) } ]
A nsA ns 1. 1602

2. 1677
3. 1462
4. 1532

Q .95Q .95 The inc ome of A mit  in 2 0 1 9 was  ₹2 3, 50 0 .  He gets  an inc rement of 3 0 % every  y ear.  What was  his  inc ome ( in ₹)  inThe inc ome of A mit  in 2 0 1 9 was  ₹2 3, 50 0 .  He gets  an inc rement of 3 0 % every  y ear.  What was  his  inc ome ( in ₹)  in
2 0 2 1 ?2 0 2 1 ?

A nsA ns 1. 30,550
2. 37,600
3. 39,715
4. 23,500

Q .96Q .96 Three taps ,  A ,  B  and C ,  c an fil l  a  tank  in 3 7  hours  3 0  minutes ,  50  hours ,  and 3 0  hours ,  res pec t ively .  I f  tap A  runsThree taps ,  A ,  B  and C ,  c an fil l  a  tank  in 3 7  hours  3 0  minutes ,  50  hours ,  and 3 0  hours ,  res pec t ively .  I f  tap A  runs
c ontinuous ly  and taps  B  and C  are opened alternately  for  one hour  eac h,  s tart ing with B,  how many  hours  wi l l  i tc ontinuous ly  and taps  B  and C  are opened alternately  for  one hour  eac h,  s tart ing with B,  how many  hours  wi l l  i t
take to  fil l  the tank  to  96% c apac ity ?take to  fil l  the tank  to  96% c apac ity ?

A nsA ns 1. 12
2. 15
3. 16
4. 18

Q .97Q .97 A  pers on c overs  a  certain d is tance in 8  hours  at  a  s peed of 6  km/ h and s ome more d is tance in 1 0  hours  at  a  s peedA  pers on c overs  a  certain d is tance in 8  hours  at  a  s peed of 6  km/ h and s ome more d is tance in 1 0  hours  at  a  s peed
of 4  km/ h.  Find his  average s peed for  the ent ire d is tance c overed .of 4  km/ h.  Find his  average s peed for  the ent ire d is tance c overed .

A nsA ns 1. 

2. 

3. 

4. 

Q .98Q .98 The s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 and the third  number is  1 0 2 .  Find theThe s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 and the third  number is  1 0 2 .  Find the
average of the remaining two numbers?average of the remaining two numbers?

A nsA ns 1. 177
2. 178
3. 201.5
4. 202.5
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Q .99Q .99 A n item is  marked 80 % higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 53 %A n item is  marked 80 % higher  than its  c os t  pr ice.  E ven after  a l lowing s ome d is c ount ,  the s hopkeeper  earned 53 %
profit .  F ind the d is c ount percentage al lowed by  the s hopkeeper.profit .  F ind the d is c ount percentage al lowed by  the s hopkeeper.

A nsA ns 1. 17%
2. 16%
3. 15%
4. 13%

Q .1 0 0Q .1 0 0 The rat io  of  M ohan's  age to  his  father 's  age is  1  :  2 .  A fter  9  y ears ,  the rat io  of  their  ages  wi l l  be 4  :  7.  What was  theThe rat io  of  M ohan's  age to  his  father 's  age is  1  :  2 .  A fter  9  y ears ,  the rat io  of  their  ages  wi l l  be 4  :  7.  What was  the
rat io  of their  ages  1 8  y ears  ago?rat io  of their  ages  1 8  y ears  ago?

A nsA ns 1. 1 :  4
2. 1 :  6
3. 1 :  5
4. 1 :  3
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